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 T 
hanks to Michael Shalkey for his presentation on getting our videos 
into our computers and onto YouTube.  

How much do you trust your computer? 

    Probably a lot more than we realize.  A recent study by Volks-
wagen was performed to see if people would actually trust a car that drove 
for them. 

    From “VW to eliminate worst road hazard: drivers” (The 
Register 8/27/2010): 
    “We created a car with a second steering wheel in the rear 
where the driver couldn't see it,” he told his audience. “He or 
she pressed the autopilot button and thought the machine 
would really drive without human help. Someone drove in the 
rear seat without being recognized by her or him. Well, you 
couldn’t imagine: after a few seconds, they already took the 

newspaper and read the news articles. So they trusted already the machine, 
which was great.” 

Is it any wonder that we find a virus in the driver’s seat from time to 
time? For as inquisitive and clever as we are, we also appear to be a very 
trusting lot. 

Other tidbits 

I was having a lot of trouble coming up with a topic this month, but I do 
have some minor things to mention: 
EMET tool for older Windows: For those who are continuing to use old 

versions of Microsoft operating systems (like Windows 2000 and even Win-
dows 98), Microsoft has re-released its tool for “hardening” its applications.  
EMET version 2.0 removes or limits the ability to access “features” in Win-
dows operating systems and applications that have become backdoors allow-
ing hackers to take control of our machines. I did not look into what exactly 
is being removed; perhaps they took the pinball game out of Microsoft Excel!  
Surprisingly, there really was a magic set of keys you could strike in Excel (I 
recall it was in Office 98) and a pinball game would come up. 

The new and improved EMET also causes programs to randomly move 
around in memory (using a mechanism called ASLR) to make it more chal-

(Continued on page 11) 
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COMMAND.COM 
By Rick Curry, President Attendance at the  

August general meeting 

67 members and guests  

We welcome one new member 

 

Curry September meeting 

is moving to new spot 
Because the Boys & Girls Club will be 

painting our meeting room on Sept. 25, 
we’re going to move to a new location for 
this meeting only.  
The meeting will be in Brooks Hall at 

the Camarillo United Methodist Church,  
291 Anacapa Drive, Camarillo (see map 
on page 3). 
To get to the church coming from the 

Ventura-Oxnard area, take Highway 101 
to Carmen Drive and Carmen to Las Posas 
Road. Turn right on Las Posas and then 
left on Anacapa Drive. The church is a 
large complex. Follow the signs to Brooks 
Hall. 
If you’re coming from the Thousand 

(Continued on page 3) 
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Root Directory 

 

2006 Southwest User Group 
Conference: second place in both the 
newsletter and Web site contests. 
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By John Weigle 

jweigle@vcnet.com 

The August 2010 meeting of the CIP-
CUG board was held at the Camarillo 
Boys & Girls Club after the regular meet-
ing. Present were President Rick Curry, 
Vice President Craig Ladd, Technical 
Adviser Toby Scott, Membership Chair-
man Ken Church and TOE Editor John 
Weigle. 
Amplifier: David Minkin reported 

that two of the nine channels on the am-
plifier are not working, leaving three that 
are not being used available. Michael 
Shalkey said that he might be able to ob-
tain a working amplifier from his other 
job because his employer is replacing 
some equipment and might be willing to 
make a donation.  
Meeting CDs/DVDs: The idea raised 

at last month’s board meeting to make 
and sell CDs or DVDs of the Beginners 
SIG and possibly parts of the regular 
Q&A was discussed, but no action was 
taken. Toby said DVDs would be better 
because they have a greater capacity. No 

action was taken. There was a suggestion 
that the recordings could be placed on the 
Web site, but Toby said it’s close to its 
space limit. He said it would be better to 
post such items on YouTube and put links 
to them on our website. Toby Scott and 
Rick Curry will gather some more infor-
mation on what would be required to do 
that. 
September meeting: Because the 

Boys & Girls Club plans to paint the 
meeting room on our September meeting 
date, next month’s meeting will be held at 
the Camarillo United Methodist Church. 
291 Anacapa Drive. More details and a 
map are printed elsewhere in TOE. Be-
cause of the move, there will not be a 
Beginners SIG in September, and there 
might not be a raffle because of church 
rules. We will have coffee and doughnuts. 
The board meeting will be held at Toby 
Scott’s home because we’re renting the 
church room from 8:30 a.m. to 12:30 p.m. 
Toby, Rick and Ken will make arrange-
ments to pick up some of the equipment 
stored at the Boys & Girls Club, take it to 

the church and bring it back to the Boys 
& Girls Club. Craig will get a check from 
Helen Long for $200 to pay the church 
for the room.  
Doughnuts: Ken reported that we lost 

$5 this month on doughnuts, even though 
all were sold. He also said that the 
women providing the service have bought 
some supplies for us as a favor. The 
board expressed its appreciation for that 
but said the women should submit a bill 
and be reimbursed. The board also voted 
to raise the requested donation for dough-
nuts to 75 cents starting in September to 
cover the additional costs of the rising 
price of doughnuts. The requested dona-
tion for coffee and tea will remain at $1.  
Door prizes: Craig said we made 

money on this month’s door prizes.  
Treasurer’s report: In the absence of 

Art Lewis, Rick distributed the treasurer’s 
report, which was accepted as presented 
and which appears elsewhere in this is-
sue. 

With no further business, the meeting 
was adjourned.  

Minutes of August Board of Directors meeting 

More on meeting 

location ... 

Oaks area, get off at Lewis and turn 
left onto the frontage road. Turn right 
on Arneill Road and Arneill Road to 
Las Posas Road. Go left two blocks to 
Anacapa and then right to the church.. 
We will be in one large room, so 

there will not be a Beginners SIG in 
September. There is a large kitchen so 
we will have coffee/tea and dough-
nuts. As noted in the minutes of the 
board meeting elsewhere in this issue, 
the requested donation for doughnuts 
will increase to 75 cents; the coffee/
tea donation won’t change. 
There might not be a raffle be-

cause of church rules. 
 

(Continued from page 1) 
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Programs 

Michael Simpson and/or Abbas Me-
hdi of Iolo will discuss Search & Recover 
and Drive Scrubber at the Sept. 25 meet-
ing. 

As noted on page 1, September’s 
meeting will be in Brooks Hall at the 
Camarillo United Methodist Church,  291 
Anacapa Drive, Camarillo, because the 
Boys & Girls Club will be painting our  
regular meeting place.  

The doors open at 8:30 a.m.. The 
Internet and Networking SIG will start at 
8:45 a.m. There will not be a Computing 
101 SIG at this meeting because there is 
no separate room to hold it.  

Search and Recover is, as its name 
suggests, a program to find and get back 
accidentally deleted files. The Iolo web-
site says, “Accidentally deleted photos, 
files, songs, e-mail or videos, lost even 
years ago, can be safely recovered with a 
single click.” 

Drive Scrubber, according to the web-
site, lets users: 

“Wipe the entire drive — prevent 
personal information from falling into the 
wrong hands by securely eliminating all 
existing data before selling, discarding, 
donating or reassigning your PC. 

“Wipe just the free space, erasing all 
remnants of deleted data to maintain on-
going security, while keeping existing 
files and operating system intact. 

“Clean and restore drives that have 
been infected or damaged by stubborn 
spyware or viruses. One wipe with 
DriveScrubber and your drives are as 
good as new.” 

The Iolo website is http://iolo.com. 
Other coming meetings: 
Oct. 23: Klassic Specialities, Don 

Baker (ink, paper and other printing 
needs). 

Nov. 20, Third Saturday: Jim Glass, 
Ins & Outs of Digital Photography.  

Dec. 18, Third Saturday: Toby Scott 
and Michael Shalkey on a topic to be 
announced. 

 

SIGs  

Except for the Thousand Oaks PC 
Club Photo Group, the Special Interest 

Groups (SIGs) are sponsored by CIPCUG 
and led by volunteer club members.  

Unless otherwise noted, the CIPCUG 
SIGs run from 6:30 to 8:30 p.m. at 
Ventura County Computers, 2175 
Goodyear Ave., Unit 117, Ventura; phone 
289-3960. From the 101 Freeway, exit at 
Telephone, take Telephone south to 
McGrath, turn left and go one block. Turn 
right on Goodyear and right again into the 
second driveway. Unit 117 is the back, 
right corner of the building.  

The pre-meeting SIGs are at 8:45 a.m. 
at the Boys & Girls Club. The after-
meeting SIG is at 1:30 p.m. at The Star, 
550 Camarillo Center Drive, Camarillo.  

There is no charge for members to 
attend the CIPCUG SIGs.  

Until further notice, the Photo 

Group is not accepting new members 

or guests because it is close to 

outgrowing its meeting room. The 
TOPCC Photo Group, which  meets at 
6:30 p.m. at the Thousand Oaks Library, 
1401 E. Janss Road, charges $3 per 
meeting for those who are not members 
of the Thousand Oaks PC Club. The Web 
site is http://topcc.org/dnn/SIGsPrograms/
PhotoGroup/tabid/65/Default.aspx. 

The general schedule  

First Monday (except in months that 
have holidays on or near the first 

Monday): TOPCC Photo Group. It is not 

taking new members or guests until 

further notice.  

Fourth Tuesday: Linux. 
Fourth Saturday (or the regular 

meeting day): Computing 101 SIG 
(Jessica Scott and Mark Maidel) and 
Internet and e-mail SIG, 8:45 a.m. 
Michael Shalkey’s after-meeting SIG at 
The Star, 550 Camarillo Center Drive, 
Camarillo.  

The schedules for the balance of   
August and all of September follow: 

September 

Saturday, Sept. 25: regular meeting 
and SIGs. 

Tuesday, Sept. 28: Linux SIG. Topic 
TBA. 

Michael Shalkey will not do an after-
meeting SIG. 

October 

Saturday, Oct. 23: regular meeting 
and SIGs. 

Tuesday, Oct. 26: Linxu SIG. Topic 
TBA. 

 

Be sure to check the calendar on 

cipcug.org for updates on event pro-

grams, dates and times.  

Door prizes 
We have two types of raffle tickets: 

one for prizes offered by the presenter 
and one for club-provided prizes. The 
tickets for the presenter’s prizes are free 
and limited to one per member.  

The tickets for the club-provided 
prizes are $1 each, $5 for six tickets, $10 
for 13 tickets, $15 for 20 tickets and $20 
for 27 tickets and are available to 
anyone. Those who can’t stay until the 
drawing may sign their tickets and give 
the person selling the tickets a list of the 
prizes they would like in the order they’d 
pick them. Winners’ prizes will be held 
until the next meeting. 

Consignment table  
A consignment table is set up at every 

meeting. Anyone can buy, but only 
members can sell.  

The club gets 10 percent of the sales 
price. Sold items must be picked up at 
the end of the day’s meeting. Any items 
not picked up will become the property of 
CIPCUG and will be subject to disposal 
at the club’s discretion. 

CIPCUG is not responsible in any 
way for items bought or sold at the table. 
Each item is sold as-is unless otherwise 
stated. 

Meeting, SIG notices  
If you would like e-mail notices of 

regular meetings and SIGs, go to 
www.cipcug.org, where you’ll find a link 
on the home page to sign up. The URL is 
cipcug.org/listserv.cfm.  

You will need your membership 
number, which is on the back cover of 

TOE, to complete the sign-up. 

Coming events  

Iolo products will be topic at new location 
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Unless otherwise noted, the questions 

are answered by Toby Scott, our 

technical adviser and a partner in 

Ventura County Computers. Michael 

Shalkey runs the computer. — Editor 

Internet and networking SIG 

Reported by John Weigle 

Introduction 

Toby Scott: If I seem a little distracted 
today, it’s because we had major prob-
lems at the shop with our mail server. 
One of clients was infected with a virus, 
infected us and we became a server of 
spam, which I discovered when I found 
18,000 spam messages in the queue. I got 
those cleaned out, blocked the client’s 
account by changing the password and 
not telling him the new one until the of-
fending machine was cleaned up.  

We ended up on two blacklists, how-
ever, which meant that our outgoing mail 
was blocked by many ISPs. It was easy to 
get off one of them. I called, explained 
the situation, told them it had been fixed 
and they said fine. The second one, how-
ever, said it would take a month to be 
taken off the list unless we wanted to pay 
$91 for faster service, which did not seem 
reasonable to me. 

Yahoo blocked us and when I talked 
to them they said we were permanently 
temporarily deferred, meaning mail 
would be blocked for some period and 
then released as they watched what was 
happening.  

I ended up changing the IP address for 
the e-mail server – we have several IP 
addresses – which solved the problem, 
but I’ve had about eight hours sleep in the 
past three days. As a result, we won’t be 
updating the CIPCUG flash drives today. 

(Craig Ladd announced later in the 
meeting that some 8 GB flash drives have 
been made and will be available at to-
day’s meeting and the September meeting 
for $20.) 

IP addresses 

Q: What is an IP address, and can I 
assign them myself? 

A: The answer is yes and no. On the 
Internet you can not assign an IP address. 
That function is handled by your Internet 

Service Provider. If you have a home 
network, however, you can assign the IP 
addresses behind your router so that, for 
instance, you networked printer is always 
at the same IP address. 

An IP address looks like this: 
216.27.61.137. Because computers talk to 
each other in binary form, that address 
becomes  11011000.00011011.00111101. 
10001001, so each set of numbers is 
called an octet (an 8 bit number). IP ad-
dresses are coordinated by the Internet 
Assigned Numbers Authority (http://
www.iana.org). The binary numbering 
system allows a total of 256 pieces of 
information per octet. 

There are several classes of IP ad-
dresses: 

Class A is an assignment of the first 
octet by IANA, and then the ISP can as-
sign all the remaining octets.   

Class B addresses are for medium-
size networks. The first two octets are 
assigned by IANA and the ISP assigns 
the remaining two octets. 

Class C addresses are for small to 
mid-size businesses. The first three octets 
are assigned to the end user and the last 
octet is handled internally.   

Broadcast messages for all computers 
on a network use the IP address 
255.255.255.255. 

Assignments of IP addresses are geo-
graphically related.  The Internet uses 
what is called “hot potato routing,” which 
means each server that gets a message 
looks for a server that is closer to the ulti-
mate destination and sends it on until it 
reaches the end of the line. It is able to do 
this because it knows where the IP ad-
dress is located — if not precisely, it will 
know what ISP server to send it to and 
that server will know. 

Users who have a need for a static — 
that is, never changing — IP address can 
obtain one from their ISP, for an addi-
tional fee. Most home users don’t have 
static addresses, so their IP address 
changes each time they log in to the Inter-
net and even during a session.  

Home users with a router usually have 
their IP address dynamically assigned by 
the router, but they can, for instance, set 
up a printer so it always uses the same 
internal IP.  Most routers are set up to use 
the subnet of 192.168.1.x where each 
computer or device on the network re-
ceives a different last octet.  Every com-
puter has to have a unique IP address. 
Most routers will assign themselves the 
IP address of 192.168.1.1 and assign IP 
addresses from 192.168.1.100 to 
192.168.1.200.  If you have a printer or 
home server you wish to have an assigned 
IP address, you should assign it one of the 
values between 192.168.1.2 and 
192.168.1.99 (assuming your router con-
forms to “normal” above). 

(For more information about IP ad-
dresses, check the article at http://
computer.howstuffworks.com/internet/
basics/question549.htm)  

Uploading to YouTube 

Q: How do you upload to YouTube? 
A: Michael: Create an account and 

upload the file. 
Toby: Create your account and follow 

the instructions. It must be less than 15 
minutes, smaller than 2 GB and in an 
acceptable format. Click the Upload link 
at the top of any YouTube page and fol-
low the directions. Information on file 
formats can be found at http://
www.google.com/support/youtube/bin/

(Continued on page 6) 

This month’s Q&A topics: 
Internet and e-networking SIG 
Introduction 
IP addresses 
Uploading to YouTube 
Security for public networks 
Merging Gmail contacts 
Broken.OpenCommand message 

Next operating system 
Support for Windows XP 
 
Regular Q&A 
The regular Q&A is not available 

this month. We’ll report on it and the 
September Q&A in the next issue. 

Q&A 

IP addresses, uploading to YouTube 
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More Q&A: Broken.OpenCommand message  

answer.py?answer=55744. General infor-
mation on uploading can be found at 
http://www.google.com/support/youtube/
bin/answer.py?hl=en&answer=57924. 

Security for public networks 

Q: What security precautions should I 
take when using a computer in a public 
setting? When I’m travelling I create a 
new e-mail address just for that trip. 

A: Using a disposable address is ex-
actly what you should do. You can use 
Gmail, Hotmail or Yahoo for such an 
a d d r e s s .  A t  h t t p : / /
www.guerrillamail.com, you can get an 
address that will be valid for 60 minutes. 

You can also use your regular e-mail 
account on a trip by changing the pass-
word before you leave, using the account 
on the trip and changing the password 
again when you return home. Do this 
carefully so it’s not easy to guess your 
password from the temporary password. 
For instance, don’t make the temporary 
password password2 if your regular pass-
word is password (which, of course, is 
one of the most insecure passwords you 
can pick). Don’t do any variation of your 
original password. 

Michael: Be sure to turn file sharing 
off, too. 

Toby: Good point. That’s especially 
important in Windows XP. Vista and 
Windows 7 will ask if you’re on a public 
or private network when you sign on and 
automatically turn off file sharing if you 
say public network. 

Michael: XP will be dead in a few 
years anyway. 

Toby: Not necessarily. Windows 7 
Pro gives you downgrade rights to XP, 
which expire in 2020. There won’t be 
security patches for it by then, but Micro-
soft does it that way because some U.S. 
security agencies require hack-proof in-
stalls on certain things. For example, we 
have a client who makes black boxes for 
airplanes and they’re allowed to use only 
Windows 2000 for those. It takes the gov-
ernment a long time to approve new oper-
ating systems for embedded systems like 
that. 

Merging Gmail contacts 

Q: When I open Gmail it shows Con-

tacts and More contacts. How do I merge 
them so they’re all together? 

A: Open the Contacts list, go to More 
actions > Merge contacts. Click the box 
on the ones you want to merge (or the 
box at the top of the list if you want to 
merge all) and follow the prompts. 

Broken.OpenCommand message 

Q: I’m getting an antivirus warning on 
b o t h  c ompu t e r s  a bo u t  B r o -
ken.OpenCommand. 

A: This could be a rootkit, a program 
that executes before or as Windows boots 
and Installs itself underneath the level of 
the operating system and passes through 
information and commands to the operat-
ing system.  

Michael and Toby look at the printout 
of the message and see it’s trying to open 
Notepad. Michael searches on the Web 
while Toby continues the rootkit discus-
sion. 

Toby: About the only way to get rid 
of a rootkit, which reinstalls itself each 
time Windows boots, is to put the hard 
drive in another computer, and scan with 
that computer’s antivirus so Windows is 
not running on the drive being scanned. 
Another approach is to use a bootable CD 
or flash drive. 

Michael finds a posting from Mal-
wareBytes that says it changed the pro-
gram and the way it edited the registry. A 
one-time fix was made that should have 
solved the problem. 

Toby: But be very careful if you do 
get that the same file removed on a virus 
or spyware scan consistently because that 
would be a sign of a rootkit. 

Next operating system 

Q: What will the next operating sys-
tem be? 

A: No one knows for sure, but for the 
moment it’s being called Windows 8. 
That might be a code name or the actual 
name used when it’s released.  

Generally, Microsoft needs a new 
operating system about every three years 
to sustain its revenue. We’re in the first 
year of Windows 7. Microsoft won’t an-
nounce a date this early because they 
could run into problems and don’t want to 
get locked in. The release might be de-
layed because Microsoft worked a lot of 

security features in Vista and 7 and is less 
than happy with the results. It might take 
Microsoft a little longer to roll out the 
next one. 

Michael: There’s a tentative date of 
2011, but that’s a “soft deadline.” I ex-
pect Microsoft to release a beta of the 
next version because of the success of the 
“Windows 7 was my idea” ad campaign. 
Many people were using the beta of Win-
dows 7, but how many people have ever 
used a beta of a Mac OS? None. 

Toby: Many people used the beta of 
Windows 7 as their main operating sys-
tem. In fact, one of the big critics of Vista 
said that the beta of Windows 7 was the 
best operating system Microsoft ever pro-
duced. That’s quite a statement.  

Michael and I were having no prob-
lems with the beta version, which we 
used consistently. Rick didn’t install the 
beta because he’s more interested in hard-
ware than software. That’s one of the 
continuing discussions in our office. I’ll 
ask Rick what hardware I need and he 
tells me, but he doesn’t care about the 
software and I don’t care that much about 
the hardware.  

Support for Windows XP 

Q: What’s the situation on support for 
XP?  

A: Michael: Support has ended for 
Windows 2000. 

Toby: You can’t go on the Internet 
with Windows 2000 any more. Without 
security patches, it is just too dangerous.  
Support has ended for Windows XP Ser-
vice Packs 1 and 2.  

Service Pack 3 is still being sup-
ported, with no firm end-of-life date an-
nounced.  

The dates can change often. Windows 
98 was extended three times and Win-
dows 2000 was extended four or five 
times. If you believe the published dates 
you’d believe in the tooth fairy. 

 

Regular Q&A 

A combination of computer glitches 
and other problems made it impossible to 
get the regular Q&A transcribed before 
the deadline for this issue. We’ll double 
up in the next issue. — Editor  

(Continued from page 5) 
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By John Weigle 

jweigle@vcnet.com 

S 
eptember’s program was a mix 
of how-to information presented 
by Michael Shalkey. Items cov-
ered were how to make “a movie 

of what’s going on on your computer” for 
training or archive purposes, how to back 
up e-mail and how to rename batches of 
photos at once. 

Video training 

Sooner or later, everyone seems to get 
a “how do I do …” question from another 
computer user. Sometimes you can an-
swer the question over the phone by just 
talking someone through a problem, but 
other times the person really needs to see 
what you’re doing. 

One way to do this is to use the free 
CamStudio (http:/Camstudio.org) pro-
gram, with which you can record every-
thing that happens on our screen. If you 
want to add sound so you can speak while 
showing what you’re doing, you will 
need a microphone to connect to the com-
puter. CamStudio is a free, open source 
program that lets you record what hap-
pens on the screen, record audio and an-
notate the screen shots. 

You can record the entire screen or 
just part of it. The Region menu gives 
you the choices of Region, Fixed Region 
or Full Screen. If you have clicked on 
Fixed Region, when you click on File > 
Record, you’ll be able to draw a box 
around the screen area you want to re-
cord. 

The Options menu gives choices of 
Do not record audio, Record audio from 
microphone and Record audio from 
speakers, along with options for several 
other functions. 

After picking the options for region 
and audio, click on File > Record and 
proceed with whatever you want to show. 
When you’re finished, click on File > 
Pause or File > Stop, depending on which 
you want to do. 

Michael suggested using the Use MS 
Video (.avi) option when picking the for-
mat to record in.  

The Snipping Tool in Windows Vista 
and 7 provides a similar function but is a 

still picture of one point in time. CamStu-
dio provides a continuing video of every 
step you take. 

CamStudio is a good way for people 
to provide a program for a group (such as 
CIPCUG), to record conversations using 
a webcam so you can see them again or to 
record the contents of Web pages. It will 
record a YouTube video although the 
quality drops off. 

You can edit video in CamStudio to 
cut the time down to an acceptable one 
for YouTube uploads. YouTube also has 
“how to” videos for its options. 

Backing up e-mail 

E-mail programs store information in 
a variety of ways, so the instructions for 
each program vary a bit. For his demon-
stration, Michael used Windows Live 
Mail, part of Windows Live Essentials, 
which can be downloaded at http://
e xp l o r e . l i v e . c om/w i nd ows - l i v e -
essentials?os=other. 

(To find out where mail is stored in 
Windows Mail, Windows Live Mail and 
Outlook Express, go to http://
email.about.com/od/livemaildesktoptips/
qt/Identify_Your_Windows_Mail_Live_ 
Mail_or_OE_Store_Folder.htm?rd=1. 
Outlook stores all its data in .pst files. 
Other programs vary, so start with the 
program’s own help files or look for an 
export menu item. If neither of those 
works, search for the program with your 
favorite search tool.) 

No matter what program you use, 
Michael said, you’ll want to back up e-
mail messages, e-mail account informa-
tion and contacts/address books.  

The account information is important, 
he said, because he’s had clients set their 
e-mail programs to automatically open 
and download messages by remembering 
their password, and then forgetting the 
password because they never have to type 
it in. That can be a big problem if you 
have to reinstall a program or get a new 
computer or hard drive and have to start 
over. 

Windows Live Mail (and even Out-
look Express) provides ways to back up 
all of those. 

For messages, you want to export the 
messages to an external hard drive, flash 
drive, CD or DVD. Your choice depends 
on how much information you’re saving. 
Backing the information up the same 
drive it’s already on is of no value if the 
drive fails. To bring the mail back to a 
new installation of the program you use 
the import function. 

The contacts list (address book in 
some programs) is usually exported to 
a .csv (comma separated values) file, 
which can be read by most programs.  

To export and import account settings 
go to the Tools menu for the two options.  

(Later, Michael determined that what 
he showed for e-mail backup works for 

(Continued on page 8) 

Program: 3 in 1 

Video training, backing up e-mail, photo batch work 

The opening screen of CamStudio is at left. The File menu, showing the Re-
cord, Stop, Pause and Exit options is at right. 
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Important Q&A reminder: Please wait for the microphone to ask, answer or comment on a question. Al-
though we have several microphones during the   Q&A sessions, they do not pick up sounds from far 
away. While this eliminates the general background noise from the tape, it also means that useful informa-
tion offered without a microphone is not recorded and, therefore, can not be transcribed for TOE.  

Outlook Express as well — at least the 
export mail settings and Address book. 

(The Windows Live Mail 2010 Beta  
does not move the password, found out, 
adding, “ I am so sad.”) 

Resizing, renaming photos 

As digital camera users quickly dis-
cover, photo names are something like 
IMGP0329.jpg, which gives you little 
useful information about the picture. Mi-
chael showed a way to resize and rename 
many pictures at a time using the free 
I r f a nV i ew ( I r f a nV i ew h t t p : / /
www.irfanview.com). 

To do this, you’re going to use the 
File > Batch Conversion/Rename func-
tion. 

To rename the pictures, select the 
ones with similar subjects (summer visit 
to Aunt Sally’s, Trip to Disneyland, 
Johnny’s birthday party, etc.). You have 
to do this one subject at a time. If you sort 
the pictures by date in whatever folder 
you’ve stored them, it should be fairly 
easy to find all the related ones close to-
gether. If they’re separated, use Ctrl + 
Click to pick them. If they’re all together, 
click on the first one, hold down the Shift 
key, scroll to the last one and click on it 
to pick all pictures between the first and 
last. 

Open the Batch Conversion/Rename 
function. Pick a directory to put the re-
named pictures in. This can be the current 
directory or, if you don’t want to change 
the originals, a new directory so you’ll 
have copies of the original pictures with 
the new names. 

Sort the pictures by date. 
Start the process, at which point 

you’ll pick the overall name, i.e., John-
ny’sBirthdayParty. You’ll end up with 
photos with the name and a number: 
Johnny’sBirthdayParty01, etc.) 

To resize photos for easier sending in 

e-mail, use the Batch Converter/Rename 
function, select the photos and pick a new 
directory so you don’t change the origi-
nals. This is important because you want 
to keep the originals at their original sizes 
so you can use them for larger prints later 
if you want to. 

Pick a size. Michael said he likes 640 
x 480. Toby Scott suggested using 640 
for the larger dimension. In either case, 
be sure to check the Preserve aspect ratio 
box so you don’t distort the picture. 

General information 

Windows Media Player and most 

other players can play .avi files, which is 
the standard for most players. 

Windows Live Movie Maker lets you 
prepare movies that you can send to an 
individual or a site. It’s free and can be 
downloaded at the Windows Live Essen-
tial site noted above.  

On the Net: 

Michael has posted the recordings on 

You Tube. 

Backing up e-mail:  http: //

www.youtube.com/watch?v=Ttax120ZOls 

Batch re-sizing, renaming photos: 

h t t p : / /www . y ou t ub e . c om /wa t c h?

v=S_jlyI38MX8 

(Continued from page 7) 

More on resizing, renaming pictures 

The Batch Conversion/Rename function in IrfanView is in the File menu. 
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The Outer Edge is printed and prepared for mailing by: 

Members’  
classified ads 

Classified ads are free to 
members. Each ad is limited 
to 105 characters, including 
spaces and to one ad per 
member per month. Copy has 
to be to John Weigle, editor of 
TOE (editor@cipcug.org), 
within the week after the 
regular meeting. Otherwise, 
the ad is held to the following 
month.  

 
Wanted 

Have a small flash drive 
that you don’t use? I could 
make good use of any 128 
MB flash drives you care to 
donate for next year’s 
vo lun teer  income tax 
program. — Art Lewis  

 
 

Other categories as 
needed Smart Computing tips 

and fun facts 

Reprinted with permission from Smart Computing. Visit 

http:// www.SmartComputing.com/Groups to learn what Smart 

Computing can do for you and your user group. 

 
Unavailable websites: Occasionally, you may be unable to 

access a website that you visited previously without any trou-
bles. This can happen if the website’s ISP (Internet service pro-
vider) temporarily disabled the site, if the administrator failed 
to renew the Web registry data, or if too many people try ac-
cessing the site at the same time. Often when a site you access 
is unavailable, you will receive the “HTTP 404 Not Found” 
error message. One way to know if a site is temporarily down is 
to check another commercial site to see if your Internet connec-
tion is active. If you can access some sites but not one particular 
site, you may simply need to try accessing the site at a later 
time. You can also try deleting your Internet temporary files. 
To do this in Internet Explorer 8, for instance, open the Tools 
menu and select Internet Options. Next, click the Delete button 
under the Browsing History section, make sure to select Tem-
porary Internet Files, and click Delete again. When you delete 
these temporary files, IE can access Web sites instead of using 
possibly outdated local files on your computer for a particular 
site. 
E-readers offer digital convenience: E-readers can bring 

you books, blogs, and the Web wherever and whenever you 
need them. New electronic ink displays are easy on the eyes 
and provide a natural and familiar reading experience. And on 
models with Wi-Fi or 3G capabilities, you can shop right on the 
device: Select and pay for your purchase, and you can be read-
ing your new book or magazine within a minute or two. 
Upload photos and videos to a digital frame: The process 

of uploading photos and videos to a digital frame depends on 
what type of frame you have. Traditional frames require you to 
save photos on a USB flash drive or memory card and connect 
it to the frame. Wireless digital frames can stream pictures from 
your computer or online sharing sites over your wireless home 
network.  

 
To ensure CIPCUG receives credit for new subscriptions 

and renewals, always subscribe and renew using the Subscribe 

or Renew Today! feature available within the User Group 

portion of the Smart Computing Web site. From here, select us 

from the drop-down list provided to ensure we received credit 

for the subscription order.  

You can also call 800-733-3809 to subscribe or renew and 

give us credit by telling the representative you want us to 

receive credit for the order.  

Following these instructions will ensure that we get as many 

free subscriptions as we possibly can. 
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By Jeff Levy 

This lesson is copyright by Jeff Levy 

and reprinted with permission. All of his 

more than 400 lessons for both the PC 

and the Mac can be found on his Web 

site, jefflevy.com.  

 

S 
ometimes you might want to 
open a file with a specific 
program, but you don’t 
necessarily want to have to open 

that program every time. So what do you 
do? That’s easy. Here’s the shortcut. 

Click on Start and then on All 
programs. Now right-click on the 
program you’d like to use for limited file 
viewing and click on “pin to taskbar.” 

This will put what is essentially a 
quick launch-like icon on your task bar. 
Now, locate a file you’d like to open, 
hold shift down, and then drag the file to 
the icon you pinned to your taskbar. 

    That opens the file in 
the program you pinned 
to your task bar. 
    This trick also works 
in Windows Vista, 
although you won’t need 
to pin anything to the 
taskbar. Just make sure 
the program you want to 
use to open files with is 

in the Quicklaunch section of your 
Taskbar, located next to the start button, 
and then follow the same steps. If your 
Vista computer doesn’t have a 
Quicklaunch section, right-click on a 
blank space on the taskbar, select 
toolbars, and then click on Quicklaunch. 

 

“Jeff Levy on Computers” can be 

heard from 3 to 44 p.m. every Saturday   

on KABC, 790 AM. Sports events often 

force a time change in the show, so check 

his website regularly for the current 

week’s scheduled. Jeff’s notes for every 

show are at www.jefflevy.com. Click on 

Show Notes on the opening page to ac-

cess a wealth of information.  

Jeff has added an additional project 

to his list of tasks: Snapshot Talk Radio, 

Your Eye on the World of Photography. 

T h e  W e b  s i t e  i s  h t t p : / /

www.snapshottalkradio.com. Jeff co-

hosts the program with Timothy E. 

Goodwin, The Photo Professor. The 

website's pages are Home, About the 

Hosts, Tim's Gallery, How to, Ask Jeff & 

Tim, Cameras, Printers, Accessories, 

Show Notes, Pod Casts and Show 

Information.  

The website says the show is on the 

following stations: Los Angeles (KABC – 

AM), San Francisco (KNEW – AM), 

Seattle (KVI – AM) and Salt Lake City 

(Freedom 570 – AM).  

Learning  
with Levy 

LEVY 

 

VCC new PC SSD Upgrade 
40GB X2540GB X2540GB X2540GB X25----V  Solid State Drive Upgrade $150.00V  Solid State Drive Upgrade $150.00V  Solid State Drive Upgrade $150.00V  Solid State Drive Upgrade $150.00    

80GB Intel X2580GB Intel X2580GB Intel X2580GB Intel X25----M Solid State Drive Upgrade $250.00M Solid State Drive Upgrade $250.00M Solid State Drive Upgrade $250.00M Solid State Drive Upgrade $250.00    
160GB Intel X25160GB Intel X25160GB Intel X25160GB Intel X25----M  Solid State Drive Upgrade $475.00M  Solid State Drive Upgrade $475.00M  Solid State Drive Upgrade $475.00M  Solid State Drive Upgrade $475.00    

You know you want one. Don’t wait. Do your part to You know you want one. Don’t wait. Do your part to You know you want one. Don’t wait. Do your part to You know you want one. Don’t wait. Do your part to 
stimulate the economy now! We’re waiting.stimulate the economy now! We’re waiting.stimulate the economy now! We’re waiting.stimulate the economy now! We’re waiting. 

 

My SSD Rocks! 
Be the first on your block with this new technology. 
Replace your boot device with an Intel SSD Drive.  
Use your mechanical drives for data storage.      

Watch you PC startup faster & 
operate like never before. 

Ventura County Computers 
  www.vccomputers.com 

(805) 289-3960 
2175 Goodyear Ave. #117 Ventura 93003 

Open a file with a specific program 
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By Helen Long 

helen@cipcug.org 

A 
 new addition to CIPCUG 
service to its members: How 
many of you still have data 
stored on 3½" floppy or 5¼" 

floppy? We can now transfer this data to 
a flash drive for $5 per floppy; you pro-
vide the flash drive. So, now your data is 
available, so you can go ahead and get 
that new computer without floppy drives. 
Isn’t that cool? 
New meeting place: Sept. 25 meeting 

only. The Boys & Girls 
Club auditorium is be-
ing painted this week-
end. Our meeting will 
be in Brooks Hall to the 
left of United Methodist 
Church of Camarillo  at 
291 Anacapa Drive. 
Iolo, makers of System 
Mechanic, will be our 
presenter. Check elsewhere in this news-
letter for a map. There is also a map on 
the front page of cipcug.org. 

We have a small supply of 8 GB flash 
drives with only about 2½ GB of free-
Ware on it, which gives you a whole 
bunch of free space. And don’t forget, 
you can get the freeware data updated for 
only $1.  

I sold three of these last month and 
only have six left to sell at $20 each. 

We lost $5 in coffee money last 
month. Come on people. Drink up! 

 

HAVE YOU RUN YOUR ANTI-

SPYWARE PROGRAMS LATELY? 

Control the auto

Practice safe computing: Back up, back up, back up 

 (And then test the backup to be sure it worked) 

CIPCUG can copy your floppy drives 

Long 

Bits & Bytes 

More on Command.com .. 

lenging for hackers to locate the vulner-
able parts of Windows. 

Search google for EMET 2.0 and look 
for the Microsoft download link. 
Patch your Linux kernels: Although 

there is no known virus that takes advan-
tage of it, there is a recent vulnerability 
that has been fixed in the Linux kernel.  
All Linux users should accept the recent 
(guard page) update/patch to the Linux 

kernel. 

Light bulbs – no CFL night lights: 

Use night lights for night lights, not the 
compact fluorescent bulbs. We recently 
had an “incident” at our house where a 
compact fluorescent (CFL) lamp burned 
out right above our bunny house-pet.  We 
were awake and removed the small ani-
mal immediately, but realized the story 
could have a sad ending if we were all 
asleep when the CFL suffered its melt-

down.  
I strongly recommend people not use 

CFLs as night-lights, especially located 
near sleeping people or pets that cannot 
escape the area. 

Modern psychology — beware of 

cursing CEOs: A recent study indicates 
that when CEOs are cursing or if they are 
not freely talking about themselves, they 
are more likely to be lying. 

Happy computing! 

(Continued from page 1) 

Word tip: slowing down a mouse selection 

H 
ave you ever noticed that 
there are times that text 
scrolls way too fast on your 
screen when you are trying to 

select it using the mouse? There are many 
ways you can attempt to slow down the 
speed at which text scrolls when you are 
using the mouse to select text. Perhaps 
the easiest is to use the keyboard in con-
junction with the mouse. You do this by 
clicking the insertion point at the position 
where you want the selection to start, and 
then hold down the SHIFT key while you 
click where you want the selection to end. 

However, if you don’t want to use the 
keyboard, and only rely on the mouse, 
your options are a bit more limited. Per-
haps the best idea is to get a mouse that 

has a scrolling wheel between the two 
buttons. Using the wheel you can scroll 
through a document at the speed you 
want. 

Those who have used Word for a 
while know that there are actually two 
mouse-scrolling speeds in Word. To use 
the slower speed when selecting text, 
move the mouse down to the horizontal 
scrollbar area. This scrolls downward at a 
relatively moderate speed. Moving the 
mouse below the horizontal scrollbar 
sends the scrolling into full-speed mode. 
The “moderate speed” zone for scrolling 
upward is the ruler bar. The actual differ-
ences between these scroll speeds de-
pends on the speed of your computer and 
how many other tasks your system is run-

ning. 
The final option to try is to slow down 

the mouse speed using Windows itself. 
Display the Control Panel, and then open 
the Mouse applet. (How you access both 
the Control Panel and the Mouse applet 
will vary, depending on your version of 
Windows.) Within the Mouse applet, 
make sure the Motion tab is displayed. 
You can adjust the Pointer Speed setting 
on this tab so it is more toward the Slow 
side. When you close the applet by click-
ing on OK, you should notice that your 
mouse speed is a bit more manageable. 

 
Copyright © 2010 by Sharon Parq Associates, 

Inc. Reprinted by permission. Thousands of free 
Microsoft Word tips can be found online at http://

word.tips.net. 
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By Bill Wayson  

bwayson@gmail.com 

Q. 
 Can Linux get a virus? 
    This question was recently 
asked in the TOE Q&A ses-
sion column. The response to 

the question was correct. Yes, viruses can 
make their way into a Linux system. But 
the response continued on, claiming that 
Windows 7 and Vista are “architecturally 
safer” than Mac or Linux, and that a 

hacker broke into a Linux 
system faster than a Win-
dows 7 system was com-
promised. Windows sys-
tems, it was explained, 
bore more numerous at-
tacks than the other two 
OSes because there are 
so many more Windows 
systems. Since I have a 
passing interest in com-
puter security, this month 
I am going to delve a bit 
deeper into the subject. 

Linux can get a virus, but the damage 
it can do is limited. For our purpose here, 
I will call any software with ill intent a 
virus. When comparing different operat-
ing systems and the risk of damage once a 
virus in contracted, more examination is 
required. The risk that a virus presents is 
the same risk you present when using 
your PC. The virus can do anything on 
your PC that you can do, but no more.  
Here, there is a distinction between Linux 
(and probably OS X) and Windows. User 
accounts on Linux are unprivileged ac-
counts. Where a Linux user can write to  
the hard drive, what files they can mod-
ify, erase, and even read, is very limited 
and confined to their own home folder 
and the files they create in the temporary 
file folder. All of the system areas are, at 
most, read-only, with very sensitive infor-
mation such as passwords being com-
pletely hidden. Thus, a virus contracted 
through the user cannot compromise the 
system. They’d have a hard time turning 
the Linux PC into a zombie. They could, 
however, peruse the user’s area to cull 
interesting information. Windows, on the 
other hand, at least through XP, has made 

it hard to keep user accounts at an un-
privileged level. Too much day-to-day 
activity requires administrative rights, so 
user accounts are generally created as 
administrator-equivalent. I have heard 
that much work has been done in Vista 
and Windows 7 to make unprivileged 
user accounts more usable. If this work is 
successful, the result should be a huge 
boon to Windows and Internet users 
alike. 

As for the relative security of Win-
dows, Linux, and OS X, that is a lively 
subject of discussion. I did search quite a 
bit for articles comparing later versions of 
Windows with Linux and OS X. I was 
unable to locate information on the white 
hat hacker conference, but I don’t doubt 
that the statements made in TOE are cor-
rect on their face. I did find, with the help 
of the Linux SIG, an article comparing 
one measure of the security of Windows 
Vista, some Linux distributions, and Mac 
OS X. This article led to a cascade of 
derivative articles claiming that Windows 
Vista may be the most secure OS there is, 
and at least one pronounced that Win-
dows 7 would be the most secure OS sim-
ply because it is the next version of Vista, 
inheriting its superior security.  The origi-
nal article, a blog posted at http://
b l o g s . c s o o n l i n e . c o m /
windows_vista_6_month_vulnerability_ 
report, and the report it is based on 
( h t t p : / / w w w . c s o o n l i n e . c o m /
pdf/6_Month_Vista_Vuln_Report.pdf), 
were written by a Microsoft security re-
searcher. The metrics that were studied 
were the number of security vulnerabili-
ties reported by the vendors, and the num-
ber of unfixed vulnerabilities remaining 
at the end of the study period. These 
numbers may not present a true apples-to-
apples comparison. Commercial vendors 
have an incentive to underreport the num-
ber of issues with their products.  Con-
versely, the open source software com-
munities have an incentive to quickly 
report issues to assure they are fixed as 
quickly as possible. Additionally, third 
parties discover flaws in closed-source 
software only when they recognize the 
effects of the flaws. With open-source 

software, third parties have the additional 
advantage of being able to see the pro-
gram code to directly discover flaws. 

What I found interesting was the dis-
cussion of the articles and how nuanced 
the subject of security could be.  It helps 
to understand what “security” is being 
compared. How were the test systems 
built: out-of-the-box, hardened by secu-
rity experts with deep knowledge of the 
PC and OS, or some other way? I was 
most persuaded that, for comparisons that 
would be used by regular PC users, “real 
life” setups — PCs that an “average” user 
would build and maintain — should be 
tested. Is the security of each entire instal-
lation being compared or just that of the 
operating systems (and what constitutes 
the “operating system” anyway)? Linux 
installations include a lot of applications 
that are not included in Windows. How-
ever, many add-on applications, such as 
Office, Adobe Reader, and a Flash player, 
exist on just about every PC running 
Windows. 

I have not done justice to this subject.  
Those interested in more can quickly find 
it with a little Web searching. The bottom 
line is that, no matter what computer sys-
tem you use, help yourself and all users 
of the Internet by keeping all your soft-
ware patched and up-to-date, become an 
informed PC user and read a bit about 
computer security, be skeptical when 
surfing the Web or reading e-mail, and 
click only what you know you must.  

If you have questions or would like to 
learn more about Linux and FOSS, come 
to the Sept. 28 Linux SIG meeting at 6:30 
p.m. at Ventura County Computers in 
Ventura. We will talk about an interesting 
discussion I heard recently about Web 
surfing, tracking, and saving cookies in 
the Adobe Flash player. Beyond that, we 
talk about all things Ubuntu, Linux, and 
open source, try to answer any questions, 
and resolve any problems that are raised. 
See the CIPCUG Web site for more infor-
mation. If you have a question or topic 
you would like the Lair or Linux SIG to 
cover, drop me a line at bway-
son@gmail.com. Until next month, happy 
computing. 

Wayson 

Penguin’s 
Lair 

Another view on operating system security 
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A 
n unfortunate combination of  Diane Mortensen’s 
computer problems and time problems for Toby 
Scott made it impossible to get the regular Q&A 
prepared in time for this issue, but we’ll catch up 

next month. The change in meeting location meant we wanted 
to be sure this issue goes in the mail in plenty of time for eve-
ryone to get the notice. 

For those of you who don’t know, Diane transcribes the 
session and Toby edits that to make sure the recording was 
clear and that he said what he meant to say before it goes to 
print (something like a member of Congress extending and 
revising remarks for the Congressional Record. 

    This issue is 16 pages rather than the usual 20 
to 24 to make up for some of the 24-page issues 
I’ve done this year. There didn’t seem to be any 
reason to scrounge up four additional pages of 
material, especially now that APCUG, the Asso-
ciation of PC User Groups,  is sending fewer 
articles to share. 

Carbonite is working 

    In fairness to Carbonite, I must update my 
report in the July issue about how poorly the 
program worked when I upgraded to Windows 7.  
(I had to reinstall it every time I wanted to use 

it.) 
On Aug. 22, I received a notice that Carbonite had released 

a new version of its software. The message didn’t say that 
problems with Windows 7 had been fixed — I am still con-
vinced that the problems I had were a result of the Carbonite 
software rather than something on my machine — but I de-
cided to download the new version and see what would hap-
pen.  

The software installed with no problems and has worked 
perfectly ever since. I am again a happy user and again feel 
confident about recommending the program as a way to have 
an offsite backup in case the worst happens and your computer 
and any local backups are stolen or destroyed by a disaster. 

If you don’t want to use Carbonite or some other offsite 
storage, at least consider backing up your data on DVDs, flash 
drives or an external hard drive that you keep at a workplace 
or somewhere far enough from your home that a fire or other 
disaster is unlikely to destroy both locations. 

Retirement is further away 

Scripps’ plans to move design and editing functions for 
The Star to Corpus Christi have been delayed again because of 
computer issues. We were recently told that the move, origi-
nally scheduled for Aug. 16, is now more likely early next 
year. That’s fine with me for a variety of reasons, including 
the tax effects of getting a severance package at the end of 
year. 

— John Weigle, editor  

Treasurer’s          

report for 

July 2010  
 By Art Lewis 

 treasurer@cipcug.org                                          

7-1-2010 through  

7-31-2010 

Category Description   

INFLOWS  
  Coffee income -3.50 
  Donation 7.00 
  Membership Income 
     Renewals    535.00 
  TOTAL MEMBERSHIP  535.00 
  Raffle  67.57 

TOTAL INFLOWS     606.07 
  

OUTFLOWS 

  Corporate Expenses 5.75 
  Rent Paid             150.00 
  TOE                306.31 

TOTAL OUTFLOWS  462.06 

 

OVERALL TOTAL  144.01 

 

Unrestricted Funds 7,249.27 
Restricted Funds 0.00 

Bank Balance 7-31-10 7,249.27 

Year to Date Income 606.07 
Year to Date Expense 462.06 
 Net Year to Date 144.01 
 

Lewis 

2010 contributors to The Outer Edge 

Your name can appear 

here, too. Share your 

knowledge with other 

members by sending an 

article, letter or computer tip 

to editor@cipcug.org. 

Ken Church 
Jerry Crocker 
Rick Curry 
Bob de Violini 
Jeff Levy 
Art Lewis 

Helen Long  
Diane Mortensen 
Sharon Parq Associates 

Inc.  
Toby Scott  
Michael Shalkey  
Phil Sorrentino (APCUG) 
Rick Smith 
S m a r t  C omp u t i n g 

magazine 
Bill Wayson 
John Weigle    

Gremlins join hands 

to block Q&A report  

 Weigle 

Editor’s 
corner 
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Membership report: 

Is it time to renew? 
By Ken Church 
email address: membership@cipcug.org 

 
Welcome -  
New Member: Wayne Shaw 
 
Attendance at the August 2010 general meeting:  
67 members and guests 
 

Total membership: 203 
 
MEMBER RENEWAL INFORMATION 
$30 for single membership, 
$35 for two or more family membership. 
 
NEW MEMBER INFORMATION 
$40 first year for single membership, 
$55 first year for two or more family member-
ship in same household. 
 
Please send your payment to:  
 

CIPCUG MEMBERSHIP 
P.O. BOX 51354 
OXNARD, CA 93031-1354 
 

Or bring your payment to the sign in table for 
the Sept. 25, 2010, meeting. 
 
July 2010 renewals payment due: 

 
 
August 2010 renewals payment due: 

 
 
 
 

September 2010 renewals payment due: 

 
 

 Mbr# Last Name 
First 
Name 

Pd to Dt 

1229 Kirschke Randy 201007 

1149 Little Robert 201007 

0873 Pass Jim 201007 

 Mbr# Last Name 
First 
Name 

Pd to Dt 

1193 Abbate Mannie 201008 

0985 Bartels Pat 201008 

0028 Fiedler Art 201008 
0806 Hurme Seppo 201008 

1111 Sperske Dineane 201008 

 Mbr# Last Name 
First 
Name 

Pd to Dt 

1207 Anderson Andy 201009 

0714 Bryan Bob 201009 

0006
T 

Burnett Bob 201009 

0613 Green Gunnar 201009 

1161 Greene William 201009 
0249 Greenway Frank 201009 

0373 Houle Robert 201009 

0773 Lang Nita 201009 

1037 Lerner Robert 201009 
0372 Pizza Tony 201009 

1208 Sheffield Craig 201009 

1036 Smith Howard 201009 

1150 Thomas Ray 201009 
1230
A 

Tolian John 201009 

1230
B 

Tolian Mary 201009 

1181 Toscano Matthew 201009 

CHURCH 
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Every month, members of the Channel 
Islands PC Users Group have access to: 

♦ The Outer Edge newsletter, which 
includes a list of members willing to help 
other members. 

♦ The general meeting, featuring a 
question-and-answer session and program 
on new software or hardware. 

♦ Special Interest Groups — special 
meetings held several times a month. 

♦ Door prizes at the regular meeting. 
 Other benefits include: 

♦ Special user group discounts on 
books and software. 

♦ An Internet service provider at a 
large discount (see next column). 

♦ A flash drive containing many 

useful freeware programs.  

♦ A chance to make friends with 
people who have similar interests. 

♦ The ability to put your knowledge 
to good use by helping other members. 
The whole concept of user groups is 
members helping members. 

 
 Please clip the coupon below and 

send with payment to CIPCUG-
Membership, P.O. Box 51354, Oxnard, 
CA 93031-1354.  

 Please make checks payable to 
CIPCUG. 

 

Dues for new members 

 Individual member, $40. 
 Family membership (same 

address), $55. 
 Renewals are $30 and $35 per 
year respectively. 

 

CIPCUG E-MAIL ADDRESS 

Members who would like to have an 
e-mail address through CIPCUG in the 
form of YourName@cipcug.org may ob-
tain one for $15 per year. 

 

CIPCUG INTERNET SERVICE 

TECH TEAM 

David Minkin, 469-6970 (cell), 484-
 2974 (home) 
  dddave@cipcug.org  
Bob Thompson, 647-2287 
  

Why join Channel Islands PC Users 
Group (CIPCUG)? 

CIPCUG MEMBERSHIP 

 APPLICATION 

 

Amount enclosed: ____________________________ 
 
Please Print the following information: 
 
Name: _______________________________________ 
 
 
Address: ______________________________________ 
 
 
City: ___________________________, State:________ 
 
 
ZIP Code: _______________________________ 
 
 
Phone (Home): ______________(Work): ______________ 
 
E-mail address: ________________________________ 
 
User level: Novice ____; Intermediate _____; Advanced 
 _____ 
 
 
 
 

Can you help the club as a volunteer? If so, what would you 
be interested in working on? 
 
 
 
 
 
 
 
 
 
 
 
 
Date __________________ Member # ____________ 
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Channel Islands PC Users 
Group Inc. 
P.O.Box 51354 
Oxnard, CA: 93031 

 DATED MATERIAL 
 Please Do Not Delay 

September 2010September 2010September 2010September 2010    meetingmeetingmeetingmeeting        

Of the Channel Islands PC Users GroupOf the Channel Islands PC Users GroupOf the Channel Islands PC Users GroupOf the Channel Islands PC Users Group    

Saturday morning, Sept. 25, at Brooks 
Hall at the Camarillo United Methodist 
Church,  291 Anacapa Drive, Camarillo, 
Calif. 
Meeting Schedule: 
 8:30 a.m. Doors open 
 8:45-9:30  Internet and networking SIG,  
                             No Computing 101 SIG 
 9:30-10:30  Business meeting, Q&A 
10:30-11:00  Break — Please contribute requested 
                             amounts for coffee and doughnuts 
11:00-12:00  Program (Iolo)    
                             Drawing (might be cancelled) 
1:30  After-meeting SIG by Michael   
               Shalkey  

DUES REMINDER 
 

If the number above your 
name is 201010, your 
membership dues are 
payable in October 2010.  
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